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Learning Outcomes

By the end of this unit the learner will be able to:

 Recognize the obstacles that prevent us from effectively managing our time
 Use a planner
 Write everything you need to remember in your planner
 Use a to-do book
 Use the viewing tools available in Outlook 2007
 Group different types of items in Outlook 2007
 Use Auto Preview in Outlook 2007

UNIT-6 Managing Time with
Outlook
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Unit 6

Managing Time with Outlook

The Power of Change
It takes time to make time work for you. If you are truly going to make any difference in your life because of today,
you have to be prepared to make some changes.

It doesn’t matter if you love them or hate them; computers are here to stay. When you combine effective time
management techniques with the proper use of a computer, you are well on the way to getting yourself organized.
In this book, we will combine time management strategies and Microsoft Office Outlook 2007 together and help
you stay focused, organized, and productive.

There is a very expensive weight loss clinic in New York State that won’t take people who aren’t prepared to make
small changes in their life. They arrive at the clinic expecting to get a diet that will make them thinner. Instead, they
are asked to go home and fill out a journal of all the changes they can make in their lives in a week. They may want
to drive to work a different way or sit at a different place when they sit down to a meal. They may try sleeping on
the other side of the bed or making little changes in their early morning routine.

When people go back to the clinic at the end of the week, staff members evaluate the changes the person was able
to make. If these changes aren’t successful, they are not accepted into the program. They are told, “If you can’t
change these small things, how will you make the major changes required to learn new ways of thinking about
food?”

Are you truly ready to try making a few changes after today? If so, this book will teach you how to develop good
time management habits and demonstrate how to apply these skills using Microsoft Outlook 2007.

 What do you believe are your top three priorities/objectives in your position?

 What do you believe are the top three obstacles to working on your priorities or meeting your
objectives as the moment?

 On a scale of one to ten, how organized would you rate yourself?

 What are the top three things you think you must do in order to be more organized?

 What would you do with any additional time if you found a way to give it to yourself?
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What do you believe are your typical strategies for managing your work and your time? Most of us try one of the following
techniques when we get snowed under:

 Work harder
 Work faster
 Get organized

 Have you ever tried these three techniques to get back on track? How successful were they in
helping you?

We all have the power of choice. Your organizational style is a result of the choices you make on a minute by
minute basis.

 Can you give some examples of how choice affects the way you work?

 What is the one activity that you know if you did superbly well and consistently would have
significant positive results in your personal life?

 If you know these things would make such a significant difference, why are you not doing them
now?

From the experts… (http://www.synergyinstituteonline.com/detail_article.php?artid=387, Tristan
Loo, 2007)

Most forms of change are tough at the best of times, so keep these five things in mind when tackling
a bad habit.

1. Learn to identify your habits. Don’t be embarrassed to ask for help from others!
2. Understand why those habits exist in the first place. What things do you have the ability to

change that will help you beat the habit?
3. Design a new good habit. We hope the information in this book will help you become more

effective at managing your work and personal time.
4. Create an action plan for that new good habit. In a perfect world, how can you make it

happen?
5. Take the top three actions that will help the most with your new habit and do them every

day for twenty-one days. Most experts that study behavior recognize that twenty-one days
of consistent practice is usually enough time for people to form a new habit.
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Case Study: Another Day at the Office
It was 7:20 a.m. when Myron arrived at the office. He was early because he wanted to clear the backlog of work
that had been piling up on his desk. He turned on the lights and started to go through yesterday's e-mail. As he
read the first message, he realized he couldn't deal with it until a colleague arrived. He set it aside and went to the
next. This item had potential application to a project he was working on, so he walked down the hall to the printer
and made a copy for his personal use.

As he continued reading his e-mail he came across a journal article of particular interest and become engrossed in
it. As he looked up, he was startled to find that others were arriving and it was nearly 9:00.

He ignored the rest of his e-mail, moved a pile of papers to a corner of his desk and reached for a project file due
tomorrow with at least two days of work yet to be completed. As he opened the file, Bill and Claire stopped by and
invited him to join them for coffee. Myron decided he could spare ten minutes. Bill and Claire were both anxious to
share the details of a play they attended last night. Before Myron realized it, thirty minutes had passed and he
hurried back to his office.

As Myron entered his office, the phone rang. It was Mr. Wilson, his manager. There was a meeting scheduled at
10:00. Could Myron sit in for him? There was something to be discussed that the department should know about.
Myron looked at his watch. There wasn't enough time to get started on the project so he pushed the file aside and
vowed to start it immediately after lunch.

The afternoon wasn't any better. A few visitors, a few phone calls, a couple of letters, and the day was over.
Nothing had been accomplished on the project that was due tomorrow. As he stuffed papers into his briefcase, he
wondered how Bill and Claire were able to attend plays during the evening.

 Did he make good use of his best time of day?

 Did he work on his high priority items?

 Did he have a problem saying no?

 Did he complete the tasks he started?

 Did he understand his problems?

 What would you recommend for Myron?



TIME MANAGEMENT

Planning Tools

Guidelines for Efficient Planning

 You can save yourself an hour a day by getting organized.
 It is important to identify and operate within two time horizons: short and long term. Anticipating events allows you to

get things done in the short term which contribute to achieving long-term objectives.
 An up-to-date master calendar can be your most helpful planning tool. However, detailed project plans should be

developed before you make entries on your master calendar.
 When things begin to get hectic, a "Things To Do Today" list helps focus attention on the highest priority items.
 Action planning worksheets, milestone charts, and PERT diagrams are excellent planning aids when properly used.
 Planning contact with colleagues and staff will help minimize disruptions. Keep a file for each person you meet with on

a regular basis, with items to be discussed.
 The most effective approaches to planning are those tailored to meet individual needs. Concepts, procedures, and

worksheets should be modified to fit individual circumstances.
 Experts say nothing should be attempted without prior planning, but there must be flexibility. Remember Murphy’s

Law: If something can go wrong, it will.

Five Point Planning Check

For every plan you make, cover all these points:
 What
 Where
 When
 How
 Who

Five Minutes Before the Hour

If you have a desk or other surface that is cluttered, set aside five minutes at the end of each hour to clear off one
small part of it. This goes for your electronic files too! At the end of your five minute session, set a timer for fifty-
five minutes so you’ll remember the next five minute period.

What can you get done in only five minutes? Try it - you’ll be surprised. At the end of two weeks you’ll see a vast
improvement. This example of instant success will bring a feeling of genuine satisfaction.

Using a Planner

A planner can be your best friend if you know what you want the planner to do and you know how to use it
effectively. Let’s take a look at some aspects and characteristics you should look for when using a planner.

What are your options when choosing a planner?
 A calendar. Like cockroaches, calendars have stood the test of time.
 A to-do list. Someone once said, “Document what you do. Someone is sure to ask.”
 A binder, with room for information, information, information.
 A computer-aided planner with time management software, such as Microsoft Office Outlook 2007.
 The digital alternative like a handheld organizer, smart phone, or Pocket PC: they can even talk to you!

When choosing your personal planning tool you should ask yourself these questions:
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 What do you want it to do?
 How big do you want it to be?
 How much do you want to spend?

 Do you currently use a planner?

 What are the essential things to look for when you purchase a planner?

 What are the key strategies for using a planner successfully?

Many types of planners can work, depending on the needs of the individual. Some people want a calendar, a week
at a glance, a space for a to-do list, and room for notes. Others want something so small it fits in a breast pocket. As
for strategies, there will be several suggestions about how people use their planner, but the most important thing
is to use them.

 How do you remember to call Jim next Wednesday? Note it in your planner.
 How do you remember to follow up with a client in six months? Note it in your planner.
 How do you remember to start a project in six weeks time? Note it in your planner.
 How do you remember not to schedule an out of town meeting for your parent’s 50th wedding anniversary? Note it in

your planner.

Once we begin using a planner, we sometimes have a tendency to only make note of meetings we must attend or
other activities that must be completed, without allotting the time required. For example, if you are attending a
meeting that will take up two hours of your time, block out that two hours. Then you have a more realistic sense of
how much time has been used and how much time you have remaining to use. Anything over 30 minutes should
have time booked.

We will explore how you can transfer information from your paper planner to Outlook 2007 (and vice versa) in
Module Three. If you learn to effectively use your paper planner in parallel with Outlook 2007, then you will be well
prepared to tackle the things you need to get done.

The To-Do Book

A to-do book is one of the simplest, most effective time management tools out there. It’s easy to use, easy to carry
around, and easy to update and customize. To start, decide how you want to record your tasks. We recommend an
elementary school style scribbler, but you can also use Tasks or Notes in Outlook 2007 or a regular notepad –
whatever works for you.

Next, make sure you write down the date on any important piece of paper. If you’re using a blank page in your
planner or To-Do book, write the date at the top of the page. Then, make a master list of everything you have to do
for home or work. (We suggest that you make different lists for each.) Now, take out a highlighter and highlight the
top three things that you want to accomplish. During the day, every time you complete an item, cross it off.
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Nothing feels better than crossing off your list items one at a time! This seemingly simple action is an excellent way
to keep your motivation high throughout the day.

At the end of the day, start a new page. Write the next day’s date on it. Then, transfer any uncompleted items to
that next page and add all the things you need to do the next day. Highlight the top two items that you want to get
done. When you start work the next morning, add any items that have come up, and highlight your third top
priority.

Some people find that master list really intimidating because you are seeing ALL of your tasks at once. A modified
approach is to lay out your week like this:

Monday Tuesday Wednesday Thursday Friday

List your tasks for each day in each column. (For the sake of simplicity, let’s say today’s Sunday, and you’re planning
out your week.) At the end of Monday, you’ll transfer any uncompleted items to Tuesday’s column and add any
new tasks. At the end of the week, you’ll transfer any uncompleted items to next week’s list.

This approach can also be used for teams. Take a whiteboard and turn it into a chart like the one above. Then write
each team member’s tasks in a different color using sticky notes or markers. (Sticky notes are useful because they
allow you to easily move tasks around, rather than re-writing them.)

Whichever methods you end up using, make sure that you stick to them! Don’t rely 100% on your memory if you
need to remember important pieces of information. Write that information down as soon as you have the chance,
and make sure you write that information in the correct place!  Even if you do remember the information, the
worst that can happen is that you’ll be reminded again.

Let’s assume you are using Outlook 2007 to record important information. Now let’s see how you can use the view
and sort commands to help organize your information.

From the experts… (http://www.addresources.org/article_day_planner_nadeau.php, Kathleen
Nadeau, Ph.D.)

Any time management resource will tell you to write down EVERYTHING in your planner. However,
a huge list of information is not very helpful unless it has some sort of order. Here are some
recommended categories for your To-Do items:

 Business To-Do’s
 Home maintenance To-Do’s
 Family To-Do’s
 Long-term goal To-Do’s
 Personal goals including fitness, health, down-time, reading time, etc.
 Social To-Do’s
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Using Outlook’s Viewing Tools
Now that you have an understanding that you should record the things you have to do, it’s time to learn how you
can use Outlook 2007 to do so much more for you than just send and receive e-mails.

Open Microsoft Office Outlook 2007 and open your Inbox folder.

Using Arrange By

Let’s discuss how to use the View menu to arrange items within a folder.

Click the View menu and point to the Arrange By submenu.

You can click any of the options to group your items by that category.
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Look at the items in our sample Inbox.

Here our items are arranged by the default category (date). This is a very useful view, but you may want to arrange
items in different ways. If you choose to arrange the items by the sender, the items will be arranged like this:

Try arranging the items in your Inbox now using the Arrange By submenu
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As a shortcut, you can click the words “Arranged By” at the top of the folder to choose a different
arrangement.

You can also click the words “<field> on top” to change the sort order.
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About Groups

In the image on the previous page, you can see how items appear in various groups (Microsoft, PowerPoint User,
and Susan Harris). You can click the title of a group to select all the messages in it, making moving and deleting
items much easier.

Click a group title in your Inbox now to select all messages under that title.

You can toggle groups on and off under the Arrange By menu. Click View Arrange By Show in Groups.

Select a folder that has lots of items in it, such as Inbox or Deleted Items, and then uncheck the
Show in Groups item shown in the image above. How has your view changed?
(We recommend you leave the Show in Groups option selected!)
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You will also find commands under the View menu to expand (show all the messages in) or collapse (hide all the
messages in) groups.

You can perform the same tasks using the plus and minus signs next to a group.

This grouping feature is also available in the Tasks folder and in some views of the Contacts and Calendar folders.

Try expanding and collapsing some different groups now.
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Using Current View

The Current View submenu under the View menu offers a wide variety of view choices. These choices are pre-made
views that let you select a commonly-used view. (Note that this submenu can change depending on the folder you
are currently viewing.

Just click to apply the view that you want.

Experiment with some of these view options now.

About AutoPreview

The last command in the View menu that we will look at is AutoPreview. (This command is only available in the
Mail and Tasks folders.)

Enable this feature now.
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This feature will show the first few lines of the task or message right in the viewing pane.

By default, the Reading Pane is turned on in Outlook 2007. This pane shows the contents of a selected item simply
by selecting the item. The AutoPreview feature is particularly useful if you keep the Reading Pane turned off.

To modify the way the Reading Pane is shown in Outlook 2007, click View and point to the Reading Pane submenu.
Then you can choose to put the pane on the right (default), the bottom of the screen, or turn the pane off.

Summary
Technologies come and go, and the nature of your work will likely change a lot over the course of your career.
However, one thing will remain the same for all of us: time. There are still sixty minutes every hour and twenty-four
hours in a day. Learning to make the most of the time you have is key to getting things done well and on time. You
have to be willing to take the time to change in order to drop the bad habits, control procrastination, and get things
done. In order to keep on top of the things you need to do in a day, it is important to get and stay organized and
make sure you have the tools you need to properly do your job.

Review Questions

How much time per day can you save if you get organized?

What three things do most people do when they get buried in too much work?

What is the most important thing you can do with a planner, no matter what type of planner you use?
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Name five ways that Outlook 2007 can arrange messages in your Inbox.

What does the AutoPreview command do?

Setting up Outlook
In this Module, we will learn how to:

 Change the way Outlook 2007 alerts you regarding incoming mail and networking activity
 Use and customize the Quick Access Toolbar
 Customize existing toolbars and the menu bar
 Create your own toolbars
 Create your own menus

Changing Notification Options
In the last Module, we discovered some of the basic time management techniques to help you stay organized.  We
also outlined how you can use the View menu in Outlook 2007 to quickly and easily sort through a folder full of e-
mail.  This Module will focus on how you can personalize Outlook 2007 to fit your working style.

About the Notification Icon

To begin, open Microsoft Office Outlook 2007 and minimize the window.

When you open Outlook, you may see an Outlook icon in the tray next to your clock in the bottom right hand
corner of your desktop, like this:

If you right-click the icon, you will see this menu:

This lets you choose if Outlook notifies you if you lose connection to your network/Internet or when you receive
new mail. You can also choose to hide Outlook when it is minimized, meaning that it will not appear in your
taskbar, just your system tray.

Click Open Outlook to maximize the Outlook window.
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Setting E-Mail Options

To set e-mail options, click the Tools menu and click Options.

Then, click the E-Mail Options button on the Preferences tab.

You will then see this E-mail Options dialog.

In the E-mail Options dialog, you can control what happens after you move, delete, or close a message; how
messages are saved; and how plain text messages are dealt with. You can also control what is included in replies
and forwards.

Now click the Advanced E-mail Options button.

In the Advanced E-mail Options dialog, you can control the more advanced settings, including AutoSave options,
how you are notified about new mail, and settings for creating messages.

Make any changes you feel would be useful in the Advanced E-mail Options and E-mail Options
dialogs and click OK.  If you don’t want to make changes at this time, click Cancel in both dialogs.
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Customizing the Quick Access Toolbar
The Microsoft Office suite underwent a major interface overhaul when Office 2007 was released. If you have used
previous versions of Outlook in the past, the main window for Outlook 2007 probably appears quite familiar.
However, if you create a new e-mail message, task, or calendar item, you probably noticed a significant change in
the interface. Menus have been replaced with tabs, and each tab contains a sequence of commands which are
shown in a ribbon.

Another aspect of the new interface you might have noticed is the Quick Access toolbar. This toolbar is located next
to the Office menu, just above the tabs. It’s a place to store your most frequently used commands and save you
from hunting around in the tabs.

Open a new e-mail message to see the Quick Access toolbar.

Using the Quick Access Toolbar

By default, there are five icons in this toolbar.

From left to right, they are Save, Undo, Redo/Repeat, Previous Item, and Next Item. Using the toolbar is as easy as
clicking the icon of the action you want to perform.

Hover your mouse cursor over each item in the Quick Access toolbar. You will be shown the name
of each command.
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Adding and Removing Buttons

The point of the Quick Access toolbar is to provide quick access to the commands you use most, so it makes sense
that you can customize it.

To add buttons to the Quick Access toolbar, click the drop-down arrow next to it. Then, click any
commands you want to add to the toolbar.

If a command has a check by it, it means it’s active and on the toolbar. To remove a command,
simply click it to remove the check.

Right-click a command in the ribbon and click Add to Quick Access Toolbar.

In the image below, we are adding the Reply to All command in the Message ribbon to the Quick Access toolbar.
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Moving the Quick Access Toolbar

Click the pull-down arrow beside the Quick Access toolbar and click the option to move the
toolbar beneath the Ribbon.

Here’s what it will look like after you move it:

To move the toolbar back to its original place, click the drop-down arrow and click Show Above
the Ribbon.

Using the Options Dialog to Customize the Toolbar

You may have noticed that the list of options in the Quick Access toolbar’s drop down menu is limited.

For advanced customization options, click the pull-down arrow next to the Quick Access toolbar
and click the More Commands item.
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This will open the Customize tab of the Editor Options dialog.
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This dialog lets you browse the entire list of commands available in Outlook 2007and select commands to add to
the Quick Access toolbar.

Select a category of commands from the combo box at the top of the dialog. Now choose a
command from that category and click Add.

This will add a command to the Quick Access Toolbar list on the right.
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To remove a command from the Quick Access toolbar list by highlighting it and clicking Remove.
You can also use the arrows to change the button’s position in the list.

You will also find commands to show the toolbar below the ribbon and to reset the toolbar to its default state.
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Customizing the Outlook Screen
Once you have customized the Quick Access toolbar to your liking, you will already be well on the way to working
more effectively in Outlook 2007. However, your customization options are not limited to just the Quick Access
toolbar. Let’s take a look at some of the other customization options available in Outlook 2007.

Customizing Toolbars

Open Outlook 2007.

There are two ways to control what icons appear on Outlook 2007’s other toolbars.

The first method is to click the drop-down arrow on the far right-hand side of a toolbar.

Next, point to Add or Remove Buttons and then point to Standard to see a list of commands.

Commands with a check are on the toolbar, commands with no check are hidden.

Click a command to change its status from hidden to visible and vice versa.

The other way to customize a toolbar is to click the Tools menu and click Customize.

This will open the Customize dialog.
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Click the Commands tab. Choose a category from the left and a command from the right. Then
simply drag and drop the command from the list onto a toolbar.

While the Customize dialog remains open, you can right-click any toolbar button to customize it.

Creating Toolbars

As you become more proficient with Outlook 2007, you will become used to using more commands. We know that
the Quick Access toolbar is great for adding commonly-used commands, but if you add too many commands, you
will end up with a cluttered toolbar.  The solution to this problem is to create your own toolbar, right from the
ground up.

Having a custom toolbar might be useful if you occasionally use Outlook 2007 for very specific tasks. Imagine that
every week you commonly use six commands to complete a task. Instead of adding those six commands to the
Quick Access toolbar but only use them once a week, you can create a custom toolbar that can be opened when
you need it, and closed when you are finished.
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Open Outlook 2007 to your Inbox folder.

To create a new toolbar, open the Customize dialog from the Tools menu.

When the Customize dialog box appears, click the Toolbars tab and then click the New button.

Enter a name for your new toolbar and click OK.

The toolbar will then appear on screen. Back in the customize dialog, click the Commands tab. Select a category,
and then drag and drop a command from the list onto the toolbar.



TIME MANAGEMENT

You will also find commands to rename and delete custom toolbars and reset default toolbars on the Toolbars tab.

When you have added the necessary commands to your toolbar, click Close in the Customize dialog box. If you
want to customize your toolbar later on, you first have to open the Customize dialog box.

To practice this concept, create a custom toolbar with five commands

Customizing the Menu Bar

If you prefer to use menus instead of toolbars, you can add extra commands to the menus that you use most often.
Customizing the menu bar is a lot like customizing toolbars.

First, click the Tools menu and click Customize, and then click the Commands tab. Now you can
drag and drop any command you like directly onto the menu bar or into a menu.
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As is the case with toolbars, when the Customize dialog is open you can right-click on any menu or command to
customize it.

Creating New Menus

In this last command customization topic, we will explore how Outlook 2007 lets you create custom menus. There
are two ways to create new menus.

The first method lets you drag solitary commands right into the menu bar. Because the main Outlook 2007 window
does not use the new Office 2007 interface, dragging commands into the menu bar lets you create a “mini” Quick
Access toolbar.

First, open the Customize dialog box by clicking the Tools menu and then clicking Customize.
Choose a command and drag it onto the menu bar.

This will place an icon in the menu bar.

To delete a command from the menu bar, make sure the Customize dialog box is open, then right-
click the command and click Delete.
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The second way of creating custom menus is to drag the New Menu command from the Customize
dialog box to the menu bar.

Now you can add commands to this new menu the same way we have added commands to existing menus and
toolbars.

Add a new menu to the menu bar and add five commands or groups of command to the bar.
Remember, to delete or modify a custom action for toolbars or menus, the Customize dialog box
needs to be open.
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Using the Options Tab

There’s one more thing in the Customize dialog that we haven’t looked at, the Options tab. These settings are used
to modify how menus and toolbars will behave on your screen. The default options for Outlook 2007 are shown
here:

Open the Customize dialog and modify three things in the Options tab.



TIME MANAGEMENT

Customizing Your Panes
Using the Reading Pane

Before we cover how to customize panes in Outlook 2007, let’s review the default items visible in Outlook 2007

1. Title bar
2. Menu bar
3. Type a question box
4. Toolbars
5. Navigation pane
6. Inbox
7. Preview/Reading pane
8. To-Do bar
9. Status bar
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Select a message in your Inbox folder.

The Reading Pane (also known as the Preview Pane) will show you a preview of the currently selected item.

Earlier you learned that the Reading pane can be shown on the right or bottom of the screen, or
can be turned off completely. For more advanced options, click the Tools menu and click Options.

Click the Other tab and then click the Reading Pane button.

Then, you will see a small dialog that will allow you to control the behavior of the pane.
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Using the To-Do Bar

The To-Do bar is a new feature in Outlook 2007. This bar is visible in all folders
except the calendar and provides quick access to upcoming tasks and
appointments.

The top section shows the current calendar month and upcoming
appointments. Any appointments that have been added to your calendar
make the date on which they fall appear bold. In the picture below, notice that
the 5th and 9th of November are in bold, meaning there is an
appointment scheduled sometime that day.

You can use the arrows to navigate through the calendar months, or you can double-click an appointment to open
it in your calendar.

If your calendar currently contains any dates with appointments, double-click the date to open
your calendar to that date.

The bottom section provides tools for tasks.

Create a new task now by clicking inside the text box that states “Type a new task.” Type “Sample
Task” into the space and press enter.
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Once you have entered a task, you can customize how Outlook will handle this task. The three buttons to the right
of your task, from left to right, will do the following.

 The bell icon indicates that you will be reminded of this task; double-click it to change when
you will receive a reminder message.

 The square in the middle lets you categorize a task. Click the square to assign the task to a
category. We will cover categories later in this manual.

 The red flag, when clicked, marks the task as complete. Click this flag now to mark the
Sample Task as complete.

To customize the appearance of the To-Do Bar, click the View menu and point to To-Do Bar.

From this menu, you can choose the position and components of the bar.

Click Options. This will open the To-Do Bar Options dialog.

Click OK once you have made any changes or click Cancel to close the dialog.
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Summary
Outlook lets you customize just about every aspect of the interface. How you decide to customize is up to you, so
take some time and add or remove as much detail as you like. You can change the Quick Access Toolbar, the layout
of the screen, and even create your own custom toolbars and menus.

Review Questions

What does the Notification icon do?

What does the pull-down arrow to the right of the Quick Access Toolbar do?

Where can the Quick Access Toolbar be displayed in relation to the ribbon?

Outlook 2007 lets you customize the Quick Access Toolbar, but this toolbar is only visible in one of the
interfaces. What two other interface items does Outlook let you create/customize?

What items does the standard To-Do Bar display?
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The Four D’s
In this Module, we will learn how to:

 Use the Do, Dump, Delay, and Delegate techniques to help manage our time
 Edit e-mail messages you have received
 Reply and forward to e-mail messages
 Download and open attachments
 Delete unnecessary e-mail messages
 Create and manage Outlook Tasks
 Send Tasks to others and manage Tasks sent to you

Do, Dump, Delay, and Delegate
Do, Dump, Delay, Delegate: these four D’s can help us manage our time better.

Do it Now
Do you spend a lot of time looking for things? Research tells us that the average person spends about 10% of the
day looking for documents. If that were so, you could gain 5 weeks a year just by getting your retrieval methods
under control! If you do have a filing system, make sure you stick to it.

Handle the little things that reduce concentration and cause anxiety, like the clutter on your desk and the
incomplete jobs. This is the opposite of prioritizing. Do the quick and dirty tasks NOW! The crises in our lives are
often the result of not handling the little things or not reacting to a niggling feeling that something is wrong. Ignore
the little toothache and you wind up with a root canal.

Another technique is to handle the worst things first. We create more stress and anxiety, and waste more time and
energy, over the things we least like to do. Why not just do them?

Try the salami technique: break things down into small steps and get started. That is how we eat an elephant, one
bite at a time.

Dump
Get rid of things you don’t need. This will take some practice and a hard-nosed approach if you have a tendency to
hang on to stuff. If throwing it out is too difficult, give it away, or ask someone else to throw it out for you. We will
discuss how you can effectively get rid of things later in this manual.

Delay
Occasionally we have legitimate delays, for example, if we are waiting for somebody else to get us information or
complete a task. However, if you have deadlines, pass on deadlines to others as well. Don’t let someone else’s lack
of planning short-circuit your deadlines.

Delegate
Don’t waste your time doing things that somebody else can do, especially if they can do them better than you. Save
your time for those things which you are uniquely qualified to do.
In The Creative Edge, author William C. Miller defines five levels of delegation:

 Tell: “Based on my decision, here’s what I want you to do.”
 Sell: “Based on my decision, here’s what I want you to do, because…”
 Consult: “Before I make a decision, I want your input.”
 Participate: “We need to make a decision together.”
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 Delegate: “You make a decision.”

You must find ways to delegate, no matter what your position is. Learn to clearly define who is to do what and let
go.

There are five steps to the delegation process:
1) Explain why the job is important.
2) Describe what is needed in terms of results (not how, but what).
3) Give the person the authority they need to do the job.
4) Indicate when the job needs to be completed and get agreement.
5) Ask for feedback to ensure a common understanding.

The Story about Everybody, Somebody, Anybody, and Nobody

There was an important job to be done and Everybody was asked to do it. Everybody was sure that Somebody
would do it. Anybody could have done it, but Nobody did it. Somebody got mad about it because it was Everybody’s
job. Everyone thought that Anybody could do it, and Nobody realized that Everybody wouldn’t do it. It ended up
that Everybody blamed Somebody when actually Nobody blamed Anybody.

 Why do we resist delegating?

 Why do we resist having others delegate to us?

 What are some important things to remember when we delegate?

Do: Working with E-mail Messages
Now that we understand the concepts behind the Four D’s, we’re going to explore how you can use Outlook 2007
to effectively deal with messages you receive. Let’s start with Do. We’ll show you how Outlook 2007 can let you
deal with important things right away by actually modifying a message that was sent to you.

No doubt you have received an e-mail message in the past that didn’t provide all the necessary information or was
missing a step that you know has to be done.

Double-click an e-mail message that you know needs some extra information
OR

You can follow along with the example below by sending an e-mail to yourself. Enter “Account
Report” as the subject and add the following text:

Hi James:
Just a reminder that I need those figures by the end of the day today!
Thanks,
Sue
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If you have sent the e-mail to yourself, open it by double-clicking it.

Once the e-mail is open, click the Other Actions button and click Edit Message.

Now, click inside the message and add some extra information. Next, click the X in the top right
hand corner to close the message. When you do so, you will be prompted to save the changes to
the message.

Click Yes to save the message.

Once you save your changes, you will see the edited message in its original location. When it comes time to refer
back to that edited message, you can count on Outlook remembering the important details for you.
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Keeping yourself “in the loop” should obviously be the most important thing you do at work! In the example on the
last few pages, we have seen how you can edit a received message to include extra information that is relevant to
you. However, if your addition to the message is something that should be known by others, you should reply to
the message. We will now continue with the “Do it now” approach to getting things done and discuss how to reply
to messages.

Replying to Messages

To reply to a message, select it in the main window and click the Reply button on the Standard
toolbar. You can also use the Ctrl + R shortcut.

Now double-click a message in your Inbox to open that message. You will find the Reply and Reply
to All commands on the Respond group of the Message tab. (The Ctrl + R and Ctrl + Shift + R
shortcuts are still valid.)

Once you perform either the Reply or Reply to All commands, you will see this window.
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At the top, you can enter the e-mail addresses of other people who might be interested in this e-mail. Notice that
the original sender is already entered in the To field, and the original subject line is included with RE: before it,
indicating that the message is a reply. If anyone was a Cc recipient of the original message, their address will not
appear in the message. Don’t forget to include them if the message contains information they need to know!

Here’s a quick overview of the three address fields:

To Messages are addressed directly to these recipients.

Cc Messages are copied to these recipients.

Bcc Messages are copied to these recipients, but their address is not visible to
other recipients.

Back in the Inbox, you will see a purple arrow in the message list indicating that the message has been replied to.
You will also see a message in the Reading Pane indicating when you replied.
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Practice replying to an e-mail by sending a message back to someone. You can also reply using
your own e-mail address.

Forwarding Messages

If you want to send the message onto another recipient, select the message and then use the
Forward command on the Standard toolbar.
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If you’ve already opened the message, you’ll find the Forward command on the Respond section
of the Message tab.

Once you click Forward (or use the Ctrl + F shortcut), you will see a window similar to the Reply window.

Note that all the address fields are blank. The subject line, however, is still the original, with FW: in front of it,
indicating that the message has been forwarded.
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All you have to do is type in your recipient’s address in the To line and your text in the body. When you’re ready,
click Send.

Back in the Inbox, you will see a blue arrow in the message list indicating that the message has been forwarded.
You will also see a message in the Reading Pane indicating when you forwarded the message.

Practice forwarding an e-mail to someone. You can also forward messages to your own e-mail
address.
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Opening and Saving Attachments

Often, if someone is sending a long document or a file that can’t be copied and pasted into an e-mail message, they
will attach the file itself. You can tell if a file is attached by the paperclip icon in the message list.

Highlight a message in your Inbox that includes an attachment.

If you don’t have any messages with attachments, ask someone to e-mail you and include an
attachment or e-mail yourself with an attachment. Once you have received a message, click the
message to highlight it.

If you look at the message details in the Reading Pane, you will see that a file is attached.

Right-click the attached file in the Reading Pane to see a list of options.
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Before you open that attachment, there are some things you should know. Not all attachments are good. A lot of
people have gotten viruses by opening e-mail attachments. Here’s what you can do to protect yourself:
 Only open attachments from people you trust.
 Check the file name. If it’s something weird like, “I LOVE YOU!” you probably shouldn’t open it.
 Save the file to your hard drive and scan it with your antivirus software.
 If you’re in doubt, just don’t open it!

Outlook will also protect you by refusing to open certain types of files (like executables, files which are actually
small programs).

If you’re sure the file is OK, right-click it and click Open.

This will open the file in its native application (in this example, the file was a PowerPoint presentation).
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Close the program you used to open the attachment.

Back in the Reading Pane, right-click the file and click Save As to save it to your computer.

Note that messages with attached files can be forwarded and replied to just like other messages.
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Using the Attachment Previewer

If someone sends you an attachment but you don’t have time to properly view it or save it to your computer, you
have the ability to preview the file. This preview option is new to Outlook 2007.

Open a message with an attachment, right-click the file, and then click Preview.

You will be asked to verify your choice.

As with all attachments, you should only preview files that you trust.

Click Preview File.

This will show a glimpse of the file in the Reading Pane. Note that not all file types can be previewed this way. If you
are unable to preview something, you will have to download the attachment and then use another program to
open it. As with all attachments, you should only do this if you trust the message source.
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Marking a Message for Follow-Up

If you simply don’t have time to deal with an important message but also don’t want to forget about the message,
Outlook 2007 includes the ability to automatically alert you about a message after a given period of time.

Open an e-mail message you want to follow up on later.

Click the Follow-Up command on the Message tab and select a
reminder flag.

Once you have selected a date for follow-up, Outlook 2007 adds a new task to
your list, using the e-mail’s title, to the specified date. For example, if you wanted to
follow up on the “Accounting Report” message tomorrow, a new task titled
“Accounting Report” would be entered as a task for tomorrow.

Select a time to follow up, and then close the message.

To add a follow-up flag for recipients, click the Flag for Recipients command. (Note that this typically only works
when the recipient is also using Outlook.)

In this dialog, you can create a custom flag for yourself or recipients. Once your options are set, click OK to apply
them.
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To set follow-up reminders on a message that you have received, right-click the message in the Inbox. Point to
Follow Up and then select Add Reminder.

Add a reminder to the message you want to follow up on.

Note that you can also clear the flag or mark the follow-up complete with this menu.

Finally, remove all flags and reminders from the message.

Dump: Working with Deleted Items
Earlier in this Module, we introduced the Four D’s to help you get things done. Now we’ll look at the second D,
Dump. Getting rid of excess things you don’t need will take some practice and a hard-nosed approach. Ask anyone
with a job that requires the use of e-mail and they’ll more than likely tell you that they always receive too much of
it.

Outlook 2007 does a very good job of filtering out junk messages, but you shouldn’t put complete faith in Outlook’s
ability to filter all the messages correctly.  Occasionally junk mail might slip through into your Inbox, and
occasionally valid e-mail gets filtered as junk. In fact, the number of junk e-mail messages sent annually number in
the tens of trillions.

However, but we’re not concerned with the items you know are useless. Instead, let’s focus on reducing the
number of useful items whose subject matter has already been dealt with. In the next Module, we will cover some
techniques to help manage your files, either physical or electronic. But for now, let’s quickly go over the four
categories of files we believe are the best for getting things sorted:

 Working Files: These include your current projects, routine functions, quick references, etc.
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 Reference Files: These are files you must refer to frequently as you work with your Working Files.
 Archive Files: Files you don’t look at anymore, but ones you need to keep for legal reasons or for other

important information that would be lost if you did completely dispose of them.
 Disaster Files: Ideally, one file that contains all vital information like identification, financial information and

references, etc. that you can take if you have to vacate the office immediately.

Anything that doesn’t fit into the above four categories can be disposed of. In the next Module, we will explore in
detail how you can categorize your files with Outlook 2007.

For now, we will discuss how to delete items in Outlook.

To delete a message, first select it in the main Outlook screen.

Select a message you know is safe to delete. If you can’t delete anything, send yourself an e-mail
with the topic “Delete Me.”

To delete a message, you can either:
 Press Delete on your keyboard
 Click the Delete button on the Standard Toolbar
 Right-click the message and click Delete
 Click the Edit menu and click Delete

The message will then be moved to the Deleted Items folder.

To retrieve a deleted item, click the Deleted Items folder in the Navigation Pane to display its
contents.
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Then, click and drag the deleted message back into the Inbox.

The best way to permanently delete everything in the Deleted Items folder is to click Tools and
then click Empty “Deleted Items” Folder.

If you perform this action, you will be warned that the item will then be permanently deleted. Click
Yes to perform the action.
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Delay: Setting up Your Outlook Task List
Murphy’s Law states that if something can go wrong, it will. Sometimes things happen that are beyond our power
to stop or change. In that case, we must adapt or deal with the situation, then move on.

Anyone will tell you that writing something down is a great way to remember something. Outlook 2007 lets you
create tasks to help you stay organized so you can remember the big and the small. We have mentioned tasks in
the past, but now we will explore them a little further because this folder is a great place to manage the things you
have to do!

Opening the Tasks Folder

Open the Tasks folder by clicking the Tasks button in the Navigation Pane.
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You can also click the Go menu and click Tasks or use the Ctrl + 4 shortcut.

When the folder opens, you will see a structure much like any mail folder, with the menu bar, toolbar, Navigation
Pane, To-Do Bar, and central window.
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Creating a New Task

To create a basic task, type “Book conference room” into either red area indicated below and then
press Enter.

Double-click this new task in either the To-Do List or the To-Do Bar to open it.

You can see a new empty task pictured below.

You can also create a new task by clicking the New button on the Standard toolbar; click the File
menu, point to New and then choose Task; or press Ctrl + N.

Now set a start date and a due date, set a reminder, and add notes.
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The image below shows a sample task that has been filled out.

Click Save and Close.

Editing a Task

To edit a task, you can double-click an item in the To-Do List to open it and make changes.
Open the “Book conference room” task now.

When a task is opened, note the Mark Complete command and the status area in the task. These commands will let
you keep track of the progress of tasks and keep on top of overdue and upcoming tasks.

You can also right-click on a task to see editing options like Open, Print, Mark Complete, Assign Task (to someone
else), etc.

Mark this task as 100% complete and then click the Mark Complete command. This will close the
task. (Note that it is not necessary to specify any percentage before you can mark a task as
complete.)
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Using the Tasks Navigation Pane

Click the Tasks link in the Navigation Pane to open that view.

By now, the Navigation Pane should look familiar to you. Let’s go over the different components.
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At the top of the bar, click All Task Items.

This view allows you to search all of the Tasks in your profile.

To search for a Task, enter a search term into the text box in the upper right-hand corner of the center pane
and press Enter.

In the next section, you can toggle between your to-do list (which shows incomplete tasks) and your tasks list
(which shows all tasks).

In the middle of the pane, there is a list of views that you can choose from. Click
any of the radio buttons under the Current View heading to view and sort your
tasks. And at the bottom, we have our standard navigation buttons.
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Using the Standard Toolbar

There are a few additional commands on the Standard toolbar for the Tasks folder.

Let’s go over each command.

Creates a new task. (If you click the arrow next to New, you will have options
to create other items as well.)

Prints the selected item.

Opens a window allowing you to choose a folder to move the item to.

Deletes the selected item.

Mark the selected task as complete.

Replies to the sender of the message you have selected.

Replies to the sender and all the other recipients of the message you have
selected.

Forwards the message you’ve selected.

Categorize the selected item.

Flag the item for follow-up.

Launches the Outlook address book.

Use this window to search through your contacts.

Launches Help.

Customizing Tasks Views

Like the other folders, you can click a view in the Navigation Pane to apply it.

You can also click the View menu and choose Arrange By to see ways to
sort your tasks. (The Current View menu offers the same view options as
the Navigation Pane.)

Add some different tasks to your Task list and then use the View
menu to change how Outlook displays the tasks.
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Delegate: Sending Task Requests
The final D we will introduce in this manual is Delegate: assigning tasks to others who are capable of the job.
Outlook 2007 lets you create tasks and assign them to other people. Outlook will also let you accept or decline
tasks that were assigned to you and send status reports.

Before we go into the nuts and bolts of sending and receiving task requests in Outlook 2007, let’s go over three
important things to keep in mind when you are faced with a task that may require delegation:

 Develop the “right” attitude. Supervisors and workers are all there to do the job together, so be fair with
your workers and be ready to provide guidance.

 Decide what to delegate and what not to delegate. There are some things that only you, the manager, can
do.

 Decide who to delegate to what task. Poor delegation choices may seriously hinder your project.

Workers need to understand that they have been chosen for a task because their manager feels that have the skill
and experience required to complete the job. Managers and supervisors need to understand that they are required
to give effective feedback throughout the delegation process and be prepared to answer questions along the way.

Let’s go over the process of delegating tasks to others and dealing with tasks delegated to you.

Create a new task in Outlook 2007 using the New command on the Standard Toolbar. Click the
Assign Task command.

The new task window changes to look like a combination of an e-mail and a task, as shown below.

The top of the window lets you add a recipient and a title, just like a new e-mail message. Below that is an area that
lets you enter the timing details, status, priority, and percent complete.
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The bottom of the task lets you write the details of the task that is to be performed.

Fill out a task and e-mail it to someone.

Click Send to assign the task.

Tasks that have been assigned to you appear in your Inbox. If you have the Preview Pane visible, you can see the
details of the task as well as the option to Accept or Decline the task.
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Double-click an assigned task to open it. The first thing you should do with the task is choose to
accept or decline by clicking the appropriate command.

Accept the task.

Next, you have the option to send a default accept response or edit the acceptance response. If you send the
default response, the task will be added to your Task list. If you choose to edit the response, a new message will
appear that will be sent to the person who delegated the task to you.
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Choose to edit the response and click OK. You can enter a custom reply message and then click Send.

If you open the task from the main window, your custom reply message is still visible. As you progress through your
task, you can send status reports to inform your supervisor of milestones or barriers in your work.
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Click the Send Status Report command.

This will open a new e-mail message complete with status information that is automatically generated by Outlook.

Add any additional information about the task and click Send, just as you would with a normal e-mail message. The
task owner will then receive the report and the task will be updated.

Once you have completed the task, mark the task as complete.



TIME MANAGEMENT

Marking a Task as Private

If your organization uses Microsoft Exchange Server, and you do not want a task’s details to be viewable by others,
you can mark it as private. Simply click the Private button on the Task tab.

This feature is also available for calendar appointments and contacts.

STING
Most people battle the habit of procrastination (putting off something you really want or need to do) more than
they would like to admit. And in spite of how good you are at setting goals, procrastination can sabotage your
personal and professional life.

Here are five steps to take the STING out of feeling overwhelmed and how you can use Outlook 2007 to avoid
procrastination.

 S: Select one thing to do.
It really pays to keep your Task lists as up-to-date as possible. As the old saying goes, an inch of planning is worth a
mile of progress. If you have taken the time to organize and prioritize your tasks, you’ll always know what you should
do next.

 T: Time yourself. Check the clock, give yourself an hour, and go for it.
You can purchase a simple kitchen timer and have it on your desk to provide a warning when your time is up. You can
always set a reminder using Outlook to warn you before a task is due.

 I: Ignore everything else while the clock is ticking.
You can set Outlook 2007 to automatically check messages as little or as often as you want. To change the frequency in
which Outlook performs a Send/Receive operation, click Tools OptionsMail Setup tab Send/Receive…
button. Modify the “Schedule an automatic send/receive every ____ minutes.” If you remove the checkmark at the
beginning of this option, Outlook will only check your messages when you click the Send/Receive command on the
Standard Toolbar.

 N: No breaks until your hour is up.
This step is really up to you. Sit up straight, make sure you are in a well-lit environment, and take things one step at a
time.

 G: Give yourself a reward when the hour is up.
How you choose to reward yourself is up to you, but we recommend a healthy snack or at least a few minutes to stand
up and stretch.
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Summary
There are lots of different factors that might hinder the way you work. We recommend you keep these Four D’s in
mind: Do, Dump, Delay, and Delegate. Don’t let your work become overrun with e-mail: only check your e-mail
twice a day when you are unlikely to be interrupted. Practice the suggestions in this module to help you effectively
deal with the issues that really matter. Outlook 2007’s Tasks are also a great way to help yourself (and others) get
things done.  And remember, if you’re feeling overwhelmed, remember the 5 steps to take the STING out of feeling
left behind.

Review Questions

What Outlook 2007 item can help you handle Delays?

What are the five steps to the delegation process?
1)
2)
3)
4)
5)

What is the difference between the Cc and Bcc fields in an e-mail message?

What is the difference between replying and forwarding an e-mail?

What are the five steps of STING?
1) S :
2) T :
3) I :
4) N :
5) G :
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Finding What You Need
In this Module, we will learn how to:

 Organize your physical workspace
 Recycle what you don't need to keep
 Sort physical and electronic files based on file type
 Deal with e-mail
 Organize your briefcase
 Sort messages using Categories
 Sort using folders and Category Search Folders
 Search for items in Outlook 2007
 Deal with junk e-mail

Organizing Your Workspace
Getting rid of clutter is one of the best things we can do to make a more efficient work environment. Remember
that electronic clutter still counts as clutter!

In this Module, we will go over the basics of organizing your physical workspace. We will also outline how you can
categorize Outlook 2007 to help deal with the e-mail you receive over the course of the day.  Keep in mind that
we’re not suggesting you use ALL of these sorting and categorization techniques. You can spend too much time
doing a good thing! We recommend you read through the concepts in this Module first and then decide which
method or combination of methods would work the best for you.

Let’s start with your desk. The object of this exercise is to purge both the work surface and the contents of the
desk. If the surface is already clear—great! However, if there are items on the desk, ask yourself if they are
necessary and/or in an effective location.

Check position of the desk:
 Is it facing the door and making interruptions more likely?
 Is the lighting adequate?
 Is the phone where it can be reached easily?
 Is there a better arrangement possible?
 Is the seating/chair adequate?

Your first step should be to get rid of things that should NOT be on the desk. Check everywhere. Look under the
blotter, on the walls surrounding the desk, in trays and drawers, etc. Collect all bits and pieces and de-clutter by
throwing out or noting information in an appropriate spot and discarding it, or filing it for the moment.

Then move to the contents of the desk. Focus first on the tools you use, such as pens, pencils, and erasers.

Check to make sure of the following:

 Do you have all tools you need, and they are in good working order?
 Tools are organized so like tools are together and easily accessible. Do you need to move any

useless tools? Do any of these tools need fixing or can they be discarded?
 Group like items together (for example: stationery, envelopes, and stamps all in one drawer).
 Store any oversupply is in a supply area. Would anyone else need some of the extra supplies?
 Tools should be stored in a shallow desk drawer, not on the desk.
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We recommend you make four piles of all the papers they have strewn around, including those on the bulletin
board, under your ink blotter or desk calendar, and on chairs.

 Take home/get out of office
 Help yourself/giveaways to colleagues
 Cool stuff you want to keep and display
 Things to be filed or written into your planner

Set up a system where vital information is saved where it can be accessed easily, and then bits of paper can be
discarded. Clutter often prevents us from using our time efficiently.

Guidelines for Keeping a Piece of Paper

Am I going to need to refer to this later?
YES: File it
NO: Recycle it

Do I have a digital copy that will suffice?
YES: Recycle it
NO: File it

Is it directly related to me or will someone else have a copy that I can refer to?
YES: Recycle it
NO: File it

Do I need to keep this for legal reasons?
YES: File it
NO: Recycle it

Does it fit in my filing system?
YES: File it
NO: Recycle it

If I file it, will I be able to find it?
YES: File it
NO: Recycle it

From the experts… (http://www.ehow.com/how_3813_organize-work-space.html, eHow Careers &
Work Editor)

Workspace Tips and Warnings
 Give computer documents logical names for faster recall.
 Try buying an organizer to keep your pens, rulers, scissors, tape, stapler, etc organized.
 Regularly review your filing cabinet, desk, and computer files to discard old materials. If you

don’t already have access to one, invest in a paper shredder.
 Replace things in the same place, every single time.
 Beware of sticky notes – they often fall off or get lost.
 Avoid stacking papers on your desk; you will inevitably misplace important documents.
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Sorting Based on File Type
The key principles of file retrieval are:

 Group similar things together
 Place them in their own space or container
 Label them clearly

Four Categories
There are also some additional steps we can take depending on what kind of files you are trying to organize. We
can usually divide our files into four categories: Working, Reference, Archive, and Disaster.

Working Files
These include your current projects, routine functions, and quick references. These are the files where you have
80% of your work. These should be within arm’s reach. They usually contain the following:

 The projects you are currently working on. This file should be cleaned occasionally, to move projects to a reference
file or to eliminate duplication.

 Fingertip information you need on a routine or daily basis, such as phone lists, client addresses, and computer codes.
 A follow-up file for each person with whom you come in contact on a regular basis, where you keep track of all

correspondence with that person.
 A file for routine functions such as sales reports or other functions performed daily/weekly/monthly.

Since these files should be within reach, they might be in a large desk drawer. Make certain they are in file folders,
labeled in large letters, and then placed in hanging file folders that are also labeled.

Usually it is more efficient to label hanging folders by category, rather than by a letter of the alphabet. Then
categories can be alphabetized or color-coded. We will cover how to file Outlook 2007 items by category later in
this manual.

Reference Files
These are files you must refer to frequently as you work on current projects. This is where the bulk of your files will
be located. Since you use these files regularly, they need to be kept handy, but not necessarily within arm’s length.
The most important thing is to arrange all information in such a way that you can pull information out of the file
easily.

Key questions for you to consider as this file is set up:
 What do I want to keep?
 What do I need to keep?
 If I wanted this information, could I find it elsewhere?

Information that should be in the reference file includes:
 Research for future projects
 Past projects to which the client refers

It can be helpful to consider key functions or components of your job, and make these the major categories for
reference files. Other files might include:

 Sponsor files
 Administrative information

Cull all duplicates or useless paper. Have a recycling bin at the ready.
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Establish subject categories, and label both file folders and hanging files. Put the file structure on paper prior to
starting the filing.

Label file drawers and create a master list of files if the amount of information is large. Remember to use large,
clear print with a fine tip felt marker.

Archive Files
These are the files nobody looks at. You keep them because the law says you must, or because you are afraid you’ll
need them if they are thrown out, or because nobody wants to take the time to do anything about them. They
should be kept in a designated location far from your work area.

Disaster Files
This is one file that contains all vital information, including identification and financial references, in case you have
to vacate the office unexpectedly. You can also have a file like this at home so you have things organized in the
event of a disaster.

Electronic Files
The key rule is that the file structure used in paper files and electronic files should parallel each other. This is all for
the sake of retrieval. Make use of keywords and search programs to help you find your files even faster.

In this information age, we have to know what we need to keep and what we don’t need to keep. Don’t keep what
you don’t need. Don’t ask, “Will I ever need this?” The answer is almost sure to be “Maybe.” Ask instead, “Where
could I get this if I needed it?”

E-mail

We recommend you check your mail twice a day.
 Checking your e-mail frequently is one of the big time-wasters of the modern office. Avoid it if you can.
 Set aside two periods when you know it will be quiet and check your mail then.
 Use separate accounts for personal and business mail.
 To change the frequency that Outlook 2007 checks your e-mail, click Tools OptionsMail Setup tab

Send/Receive… button and then modify the “Schedule an automatic send/receive” field.

Filter the spam.
With all of the junk e-mail circulating today, it's vital to use an e-mail program that can filter it by dumping junk in
the trash before it gets to you.

Outlook 2007 does a very good job of filtering junk e-mail messages, but you should never be 100% reliant on any
junk e-mail filter. Sometimes legitimate e-mail will be filtered as junk and vice versa.

Filters can also help you manage your e-mail better. For example, you can filter mailing list updates, news, and
promotions, into separate folders and read them when you're ready.

Outlook 2007 refers to these filters as rules. Rules are procedures that Outlook follows when you receive a new
message that meets the necessary criteria. We will discuss Rules later in this Module.

Organize your addresses.
Use the Contacts folder rather than manually typing addresses. It is more convenient and accurate. Creating
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distribution lists for various groups of people that you send e-mail to can also save you time.

With Outlook 2007, you can add new contacts by double-clicking in a blank area of the Contacts
folder or using the New command on the Standard Toolbar.

When a new blank contact appears, you can fill in their information. (You need to enter at least
their name and e-mail address.)

If someone e-mails you and you don’t already have them as a contact, open the e-mail they sent to
you, right-click their name at the top of the message and click Add to Outlook Contacts.

File your messages.
Organize your messages into folders or delete them as soon as you're done reading them or acted on them. Ensure
your Inbox contains only messages you haven't read or that require further action.

Outlook 2007 lets you organize your messages with colored categories, which we will cover later in this Module.

Keep messages simple.
Remember:

 A short e-mail message is a good e-mail message.
 Use a specific or descriptive subject heading.
 Keep messages, especially replies, short.
 If a simple “yes” or “no” will do, that’s all you need to say.

Briefcase

Your briefcase should be organized with:
 Tools that are needed frequently when away from the office
 Reference files that are frequently referred to such as telephone lists
 Working files that are needed
 A system for expenses

Look at your briefcase or whatever you use to carry important information around with you.

 Are you prepared with extra paper and pens?
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 Is your briefcase organized?

 What if someone looked in your vehicle: what does your vehicle say about you?

Sorting with Categories
We learned in Module One how to use the View menu to arrange information. Now it’s time to use the
organization skills we learned in this Module to sort and categorize your information.

Categories let you organize your Outlook items by groups. For example, you could mark all mail messages relating
to a particular person with a certain color category. Outlook 2007 lets you categorize e-mail, Tasks, Appointments
in your Calendar, and Contacts.

Setting up Categories

To configure categories, click the Edit menu, choose Categorize, and click All Categories.
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You will then see the Color Categories dialog.

Here, you can click a category and then choose to rename it, delete it, or add a shortcut key. You can also click the
New button to create a new category.

We suggest that you use the Rename command to assign a meaningful name to each category before you begin
using it.

If you haven’t already begun to use categories, think about the three most common types of e-mail
you receive. Then rename the Red, Yellow, and Blue Categories to reflect the most common
messages you receive.
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Assigning a Category to an Item

To assign an item to a category, click it to select it. Then, click the Categorize button on the
Standard toolbar and choose the category.

You can also use the right-click menu or the Edit menu to assign a category.

If this is the first time you have used this category, you will be prompted to rename it and add a
shortcut key. If you choose a new color, this will create a new category.

Note that you can assign multiple categories to an item. For example, the message below is assigned to the green,
blue, and red categories.
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About Quick Click

Quick Click is a feature that lets you assign an item to a category with a single click. You may have noticed an empty
square icon to the right of an item, like this e-mail message. This empty square means that no category has been
assigned to this item.

If you were to click the empty square, the Quick Click feature will automatically assign the message to a particular
category.

To set the Quick Click category, right-click any empty square or Quick Click assigned category
and click Set Quick Click.

Now you can choose which category to use when single-clicking on the category column.

You can always return to the Set Quick Click command to change the category.

Assign a Quick Click category and categorize some of the messages in your Inbox folder.
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Creating Category Search Folders

Now that you know how to categorize items, we’ll introduce the concept of Category Search Folders. These folders
are similar to the Rules we looked at earlier and can be thought of as a way to “categorize your categories” and in
fact all of your e-mail. When you open a Category Search Folder, Outlook scours your e-mail messages and displays
all messages that meet the category search criteria.

To create a search folder based on categories, click the Categorize button on the Standard toolbar
and click Create Category Search Folder.

You will then see the New Search Folder dialog. Select any of the pre-designated Search Folders from the list and
then click the Choose button to customize how mail will be sorted in the folder.

In this example, we will select Categorized Mail as the Search Folder. Now click Choose.
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Put a check beside the categories you want to include and click OK.

Then, click OK to close the New Search Folder dialog.

The new Category Search Folder will appear in the Navigation pane when viewing your e-mail. Any messages that
match the criteria for this folder will be displayed.
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Upgrading Categories

If you have upgraded from a previous version of Outlook to Outlook 2007 and have already used categories or
colored flags to filter your e-mail, you should upgrade your categories.

To do this, right-click on your Personal Folders file and click Properties.

When the Outlook Today - [Your Folder Name] Properties dialog appears, click the Upgrade to
Color Categories command in the General tab.

Outlook will then confirm what it is about to do: upgrade colored and categorized items to the new color
categories. Click Yes to proceed.
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Using Categories in a View

In most folders, you will find a “Categories” listing under either Current View or Arrange By.

For example, here is our calendar after assigning categories to our items and using the View Current View
Categories command.

Our appointments are now presented in table view, grouped by category. There are many ways to use categories in
views; don’t be afraid to experiment!
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Managing Electronic Files
By now, you should be quite familiar with creating messages and working with the default folders in Outlook. There
are lots of ways to stay organized. Earlier in this Module, we covered how to use categories and Category Search
Folders. Now you will learn how to create your own folders to manage your mail manually.

Creating Folders

To create a new folder, you can click the File menu, choose New, and click Folder.

You can also use the Ctrl + Shift + E shortcut, or right-click a folder and click New Folder.

You will then see the Create New Folder dialog.

Type a name for your folder. Next, choose
what type of items you want it to contain.
Then, choose what folder you want to place it
underneath. Click OK to add the folder.
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Renaming Folders

If you later decide to change the name of your folder, simply right-click it and click Rename.

Your cursor will then appear in the folder name. Type a new name and press Enter.

Note that default folders (such as Inbox and junk e-mail) cannot be renamed.

Think carefully about what sort of custom folders you might use during your work. Create two
custom folders and then rename them.
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Moving and Deleting Folders

To change the location of a folder, you can drag and drop it anywhere in the list of folders.

Here, we are dropping My Folder into the Inbox.

Now, the Inbox will have a plus sign next to it, indicating that it contains subfolders. You can click the plus sign to
show the folders, or click the minus sign to hide the folders.

You can also right-click a folder to move, copy, or
delete it.
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If you choose the Delete option, the folder will be moved to Deleted Items. If you choose Move or Copy, you will
see a dialog like the following.

Here, you can choose a destination folder and click OK.

Moving Messages to Folders

Moving messages to your folders is easy!

The easiest way to move a message is to click and drag a message to your desired folder.

You can select multiple messages and move them in the same way.
 Click a message, hold Shift, and then click another message to select a block of messages

at once. Then click and drag the messages.
 Press and hold Ctrl and then click individual messages to select non-adjacent messages.

Release Ctrl, and then click and drag the messages.
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You can also select the message and click the Move to Folder button on the Standard toolbar. You can then choose
a recently used folder in the list, or click the More Folders button to see a complete list of folders.

Now let’s talk more about Outlook’s mail management tools that can automate the process of moving messages
around, including the Rules and Alerts Wizard and the Organize pane.

Creating a Simple Rule

Wouldn’t it be great if every time you got an e-mail from your boss, Outlook moved it to its own folder? Outlook
has a feature to do just that; it’s called the Rules and Alerts wizard.

You can get to the wizard in one of a few ways:
 Click the Create Rule ( ) button on the Standard toolbar
 Right-click an e-mail and click Create Rule
 Click the Tools menu and click Rules and Alerts

With either of the first two choices listed above, you will see this dialog:

This is a simplified version of the Rules and Alerts wizard, which we’ll talk about in a minute. It’s a great way to
create a quick rule.

The top part of the box specifies when the rule will act and the bottom part specifies what will happen when the
type of e-mail you’ve specified arrives. At least one of the boxes in each section needs to be checked for the OK
button at the bottom to become active.

Let’s go over the first set of boxes (“When I get e-mail with all of the selected conditions”):
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 From
This box is automatically filled in with the sender of the e-mail that was selected when you clicked the
Create Rule button. It can’t be changed in this window.

 Subject contains
The white text box is automatically filled in with the subject of the e-mail that was selected when you
clicked the Create Rule button. You can edit it just by clicking in the white box, deleting the text that’s
there, and typing. (You can, of course, also modify the text that’s typed in there.)

 Sent to
This message was sent to someone using a distribution list (a predefined group of contacts), so this drop-
down list contains both the name of the distribution list and “me only.”

The second set of boxes specifies what action(s) to take when the conditions in the first set of boxes are met (“Do
the following”):

 Display in the New Item Alert Window
With the New Item Alert window, you can open the e-mail by clicking the Open Item button, edit the rule
by clicking the Edit Rule button, or just close the window.

 Play a selected sound
Plays a sound when the e-mail arrives. (Normally Outlook plays a sound anyway when you get new e-mail,
but this is a way to have Outlook play a sound for only specific e-mails, or to set a custom sound for certain
e-mails.) Click the Browse button to pick a file; you can also click the Play button to hear the sound.

 Move the item to folder
This is the most commonly used feature. This option will move e-mails that meet the conditions set out in
the first box to a folder that you specify. When you check this box, a window will pop up asking you to pick
a folder. (You can only specify one folder.)

Here is a completed Create Rule dialog. This rule will tell Outlook that when an e-mail arrives from Bugs Bunny, and
was sent to me only, Outlook should play the tada.wav sound, and move the e-mail to the Deleted Items folder.
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Clicking OK will bring up another box confirming that the rule has been created. You’ll also have an option to run
the rule on messages already in the folder, which will help if you’ve created the rule after a lot of e-mail has
arrived.

Create a rule that sends all mail from a particular person to a folder with their name.

Using the Rules and Alerts Wizard

If you click the Advanced Options button in the Create Rule dialog, you’ll see a more comprehensive view of the
Rules and Alerts dialog.

First, let’s look at the three parts of the dialog.

To launch the full Rules and Alerts dialog, click the Tools menu and click Rules and Alerts, or click the Rules and
Alerts button ( ) on the Advanced toolbar.
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The toolbar at the top of the dialog gives you options to create a new rule; to change, delete, copy, or move the
selected rule; or to run the rule now. The Options button allows you to import, export, or upgrade your rules.

If you’re just looking to make a quick change to a rule’s action, the Change Rule button is the best way to do it.

All of the options in the menu are pretty self-explanatory: you can rename the rule or add different options. You’ll
notice that there are some new options that we didn’t have in the Create Rule dialog box, like changing the
message’s priority. The options that are already in use for the rule are highlighted with an orange icon (for
example, Play a Sound and Move to Folder in the sample menu above). You can click those options to remove that
action for the rule.

The icons you see in the menu are important when we’re looking at the middle part of the Rules and
Alerts dialog.

This section is a list of the rules that are in place and the actions that Outlook will take. The actions are identified by
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the same icons that we saw in the Change Rule menu. In the list, there’s also a checkbox by the name of each rule.
If the box is checked, the rule is on; if the box is unchecked the rule is off. You can click in the checkbox to change
this on/off status.

The bottom part of the Rules and Alerts screen will give you a detailed explanation of each rule that is set up.

You can click the parts that are underlined in blue to change that action or value.
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To create a new rule, click the New Rule button in the Rules and Alerts dialog. The Rules Wizard
will launch.

First, choose to start from a template or a blank rule.
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Then, click the blue underlined items to choose a specific value.

If you start from a template, the remaining steps in the wizard will be filled out for you. Simply
confirm your choices by clicking Next, or click Finish at any point.

If you choose to use a blank rule, none of the boxes will be checked when you click Next, so it’s up to you what
conditions you pick. It’s the same idea as before: check the conditions in Step 1, and then click the underlined value
in Step 2 to specify your information. In this example, we checked “with specific words in the subject” and then
clicked “specific words” in Step 2. Now we’ll type the words and click Add.
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Once you’ve set the options in this window (you can check as many as you want) and filled out the values, you can
click Next. (If you forget to click an underlined value in step 2, Outlook will force you to fill out the information
before you proceed.) You will then see this window:

This is where you can tell Outlook what to do when the conditions that you specified in the first part of the wizard
are met. Once you check an item in Step 1 of this box, you may need to click the underlined value in Step 2 to
specify your information. You will also see the conditions that you chose in the previous dialog listed.
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Click Next to see the last set of options.

Step 1 in this window is to name your rule; this is the name that will appear in the main Rules and Alerts screen.

In Step 2, you can tell Outlook when to run the rule. The first option tells Outlook to run the rule on messages
already in the folder you’re in. The next box is checked by default; this will turn your rule on. The third box, “Create
this rule on all accounts,” is available only if you have multiple e-mail accounts set up through Outlook 2007.

Step 3 gives you a summary of the conditions, actions, and exceptions for the rule you’ve created. Once you’re
done, you can click Finish, and you’ll be back to the main Rules and Alerts screen.
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Click Apply and OK to save your changes, or cancel to remove your changes.

In summary, there are three ways to create rules in Outlook:
 Create Rule box

The easiest way with only the most frequently used options available.

 Rules and Alerts main screen
A few more options and a nicer interface, but still pretty easy to use.

 Rules Wizard
More time-consuming but has all options available.

Using the Organize Pane

Another quick way to organize your e-mail is the Organize pane.

Open the Organize Pane by clicking Tools Organize.

The options will show up in a new pane between your Standard toolbar and your mail folder.

This pane has three tabs on the left: Using Folders, Using Colors, and Using Views.

Using Folders allows you to move messages that you’ve selected to a folder. You’ll also see options in the top right
hand corner of the window to create a new folder and to open the Rules and Alerts wizard.
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The next tab is Using Colors.

First, choose whether you want to look for messages sent from or to a person. Then, type in their e-mail address.
Last, choose a color from the menu. Now, click Apply Color.

You can also tell Outlook to color messages sent only to you in a particular color; this is a good option if you get a
lot of group messages and want to be able to easily identify the messages that are just for you.

Using Views, will let you change how you currently view your mail folder.

The list of views in this last tab is pretty self-explanatory; you can change your view to all messages, AutoPreview
(which will show the first three lines of your e-mail), messages received in the last seven days, a timeline view,
unread messages, who the message was sent to, what Outlook data file it’s in, or what messages have been
downloaded.

To close the Organizer pane, click X in the upper right hand corner.
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Using Search in Outlook
We’ve covered a lot of ground on how to organize your e-mail using Outlook 2007. But even the best organizational
scheme will only help so much when you have to sort through dozens or hundreds of e-mails. Outlook 2007 uses
the Windows Desktop Search engine to help you find your items.

Installing Instant Search

If the Windows Search Engine is not already installed on your computer, you will need to install it before using the
search feature in Outlook 2007. If the feature hasn’t been installed, you will see this prompt when you open
Outlook:

Click the Yes button to go to the Microsoft Web site to download the required components.

You can also install the component from within Outlook. Simply open any mail folder and click the bar that says
“Click here to enable Instant Search.”
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With either action, you will see the Microsoft Web site open in your default Web browser. Follow the instructions
to download the necessary components.

Using the Instant Search Menu

Once installed, you will find the Instant Search tools under the Tools menu.

Here’s an overview of each option.

Instant Search Perform a quick search.

Expand the Query Builder Perform a detailed search.

Search All Mail Items Search in all mail items.

Search Desktop Search outside Outlook.

Indexing Status See what items search has catalogued.

Search Options Set search options.

Advanced Find Search using the older style dialog.

Related Messages Find messages related to the currently selected one.

Messages from Sender Find other messages from this sender.
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Performing an Instant Search

To perform an instant search, type what you’re looking for in the Instant Search box.

As you type, results matching your query will appear in the list and matching search terms will be highlighted in
yellow. You can work with the found items as you would any other item in your folders.

Once you’ve found what you’re looking for, click the X to clear the search. You can also click
another folder in the Navigation pane; the search results will clear automatically.

Note that you can also click the link at the bottom of the results to search in all mail folders, not just the current
folder.
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Using the Query Builder

For more advanced searches, use the Query Builder.

Click Tools Instant Search Expand the Query Builder.

You can also click the double arrows next to the search box.

The search box will then expand to a series of fields.
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Simply type your criteria and watch the results appear!

Like the basic search, you can change your search to include all mail items, or you can use the X to clear your
search.

About Search Folders

A standard Outlook 2007 account includes three search folders: Categorized Mail, Large Mail, and Unread Mail.
These folders are just like the Category Search Folders we looked at earlier.

To open a search folder, just click it as you would any other mail folder.

You can see your search folders in the Navigation Pane. (If you can’t see the list of search folders, click the plus sign
next to Search Folders so that the list is expanded.)
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Keep in mind that your messages aren’t actually stored in these folders. When you click one of these folders,
Outlook looks at its criteria, and then searches through all your folders to find messages that match those criteria. It
then displays the messages that match in the message pane like it would for any other folder. You can then work
with those messages like you would any other; for example, you can delete, edit, reply to, or move them.

So, if you clicked on the search folder labeled Categorized Mail, all the messages that you have assigned categories
to will appear in the message list. The other folders work the same; the Large Mail folder will show all your
messages over 100 Kb, and the Unread Mail folder will show you all the mail you haven’t read yet. (Those three
search folders are created by Outlook by default.)

If a search folder is in italics it means it hasn’t been updated recently. Once you click the folder, Outlook will update
the search and remove the italics from the folder’s name.

Customizing Search Folders

You can customize any Category Search Folder, even the ones that Outlook has created.

Right-click one of the folders and click Customize this Search Folder.

When you do that, this window will appear:

The first option in this window lets you type in this box to change the name of the search folder. The Criteria button
will bring up a small window with just the options you need. (For example, in the box above, clicking on Criteria
brings up a box prompting you to enter the name of the person.)

The Browse button lets you pick what folders this query should search. This is really useful if you want the query to
search only a few folders in Outlook. Once you click the OK button, your changes will be saved.
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You can also customize other aspects of a search folder by right-clicking on it. In this menu, you’ll see the same set
of options that other mail folders in Outlook have, including deleting or renaming the folder. Remember that
deleting the search folder doesn’t delete the messages shown in it.

Using Search Folders

Here are some examples of search folders and how you can use them every day:
 Use the criteria From Specific People and specify your boss’s e-mail address so you can easily view all the e-

mail he or she has sent you.
 Use the Important Mail criteria to see all the messages sent to you marked as urgent.
 Use the Mail with Specific Words criteria and specify the phrase “XYZ Company” to keep track of

correspondence relating to that account.
 Use the Mail Sent Directly to Me criteria and specify the Inbox folder to help you sort through the mountain

of e-mail that accumulated during your vacation.

There are lots of ways that you can use search folders to find key e-mail messages quickly and easily. The best way
to learn what works for you is to set up different search folders and play around with the options!

About Favorite Folders

Another great Outlook feature is favorite folders. Favorite folders are just a list of commonly used folders. The list is
similar to the other folders in the Navigation pane in that each folder will show the unread count. You can click any
of these folders to see its contents (for mail or item folders) or to run a query (if the folder is a search folder).

To add a folder to your Favorite Folders list, simply drag and drop
the folder into it that section of the Navigation Pane.

You can move items around in the favorite folders list by dragging and dropping
them or by right-clicking on them and choosing Move Up or Move Down. Right-
clicking will also give you the option to remove the folder from the list, or use any
of the typical folder options like renaming, deleting, copying, or moving the
folder.  Default folders like Inbox, and Sent Items cannot be deleted,
renamed, or moved.
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About Shortcut Groups

Shortcut groups are a new feature in Outlook 2007. The feature is similar to the favorite folders list, only it’s for
non-mail folders. Let’s look at an example.

Here, we have several different contacts. By default, all these contacts are stored in a group called My Contacts.
Now we’re going to add a new group called Suppliers.

Click the Add New Group link.
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You will then see a small text box appear.

Type the name of your group and press Enter.

Now, drag and drop Contacts into the group.

You can right-click the name of the group to customize it.
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Getting Rid of the Junk
We’ve already learned that there are many tools to help us deal with the volume of messages that we receive. But
what about the messages we don’t want? In this lesson, we’ll discuss the security tools that will help protect you
from unwanted mail.

Using the Junk E-Mail Filter

One not-so-great thing that happens after you’ve been using e-mail for a while is junk mail. Like that stack of flyers
and “great offers” you find in your postal mailbox, junk e-mail is usually advertisements or, worse, scams.

Outlook 2007 has some features that can help you manage that junk mail. The first step you should take is to tell
Outlook how strict it should be when it looks at your incoming e-mail.

To access these options, click Tools Options, and then click the Junk E-mail button in the
Preferences tab.

The Junk E-mail Options window will appear.

For now, we’ll focus on the Options tab; we’ll discuss the other tabs in a moment. By default, Outlook chooses the
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“Low” setting for you: this moves e-mail that’s obviously junk to the junk e-mail folder. If you choose the High level,
you risk some of your wanted e-mail going to the junk e-mail folder, but you probably won’t get any spam in your
Inbox. There’s also the “Safe Lists Only” option, which means Outlook will put all e-mail in the junk e-mail folder,
except for people that are on your safe list. (We’ll talk about safe lists in a moment.) You can also turn the junk e-
mail filter off using the first option in the list.

There’s also a checkbox at the bottom that tells Outlook to delete anything it thinks is junk e-mail. We don’t
recommended checking this because Outlook isn’t perfect; there are times it will mark an e-mail as junk when it’s
really something you want to read. If you have this option turned on, the e-mail will just be deleted and you won’t
have the option to retrieve it from the junk mail folder.

The next two checkboxes deal with the phishing filter, which we’ll discuss in a moment. The last checkbox lets
Outlook add a mark to outgoing messages that will help prevent them from being marked as junk.

Once you’ve set your options, click OK to apply them. Now, if Outlook downloads a message that it thinks is junk,
you will see this notification:

You can choose to open your junk e-mail folder, see junk e-mail options, or close the dialog. Note that opening the
junk e-mail folder is like opening any folder; just click it to display its contents.

The green number next to the folder name indicates the number of new items in the folder. Also note the message
bar in the preview pane that states what functionality was disabled in the message. If you move the message to the
Inbox, the functionality will be restored.
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You can right-click any message and choose the Junk E-Mail menu to see options for dealing with the message.
Outlook 2007 will learn from its mistakes if you correct it, so you should take the time to mark a message as Not
Junk if that applies.
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Note that if you right-click a message that is not in the junk e-mail folder, the options available will be slightly
different.
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About the Phishing Filter

Phishing is a new trend amongst scammers. Messages that do the “phishing” appear to be legitimate but are
actually designed to steal personal information. For example, you may receive a message from your bank stating
you need to confirm your personal information. However, the link in the message might actually take you to a fake
Web site that looks real. If you were to enter your personal information as requested, someone else could use that
information to get into your real bank account.

The best protection from phishing scams is to be aware. If you receive a message asking for any type of personal
information, call the company directly. Most companies will state in their fine print that you will never be
contacted for any personal information. Outlook 2007’s phishing filter disables suspicious links. By default, this
filter is enabled. You can toggle it on or off via the Junk E-Mail Options dialog.

If your organization uses Microsoft Exchange Server 2007, you can also choose to have Outlook warn you about
suspicious domain names.
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If the phishing filter is turned on, you will see a warning in the preview pane when links have been disabled. In this
case, images have been prevented from downloading (a security feature) and the message has been marked as a
possible phishing message.

To enable any functionality inside the e-mail, click the warning message. In this example, we have the option to
download the pictures in the message, change the automatic download settings, and to enable links and other
functionality (disabled by the phishing filter). There are also options for the blocked and safe senders’ lists, which
we will discuss in a moment.

If you choose to enable the functionality, the message bar will go away and you will be able to work with the
message as normal.
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About Automatic Downloads

One trick that spammers have recently employed is to include a small picture in their messages. If the picture is
downloaded, it means the e-mail address is active. Spammers can then use this information to determine the best
targets for spam.

By default, Outlook does not download pictures from most addresses. If this happens, you will see a message bar
indicating this and you will see text where the images are supposed to be.

To change the settings, right-click the message bar.

The first option will allow you to download the pictures. The second option will open the Automatic Download
section of the Trust Center, where you can choose when images will be downloaded and when you will need to
confirm download.

The other options will let you add the sender or the domain to the Safe Senders list, so all images in messages sent
from addresses in this list will be downloaded automatically.



TIME MANAGEMENT

Applying Blocked and Safe Senders Lists

Blocked and safe senders lists are a way of telling Outlook 2007 which addresses you trust and which addresses you
don’t.

To modify these lists, click the Tools Options and then click the Junk E-mail button to open
the Junk E-mail Options dialog.

Now, click the Safe Senders tab.

Adding someone to this list means e-mail will never be treated as junk, nor will Automatic Download or phishing
settings apply.

Click the Add button to add senders to the list. When the Add address or domain dialog box
appears, you can add specific addresses, such as jim@acme.com, or just a domain, like
acme.com.

In the first instance, only jim@acme.com would be treated as a safe sender; in the second instance, anyone sending
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a message from an address ending in @acme.com will be considered safe. You can also use the bottom options to
make your contacts safe senders and add people you send e-mail to, to the safe senders list.

The Blocked Senders tab looks similar to the Safe Senders tab. However, addresses and domains in this list will
always be marked as junk e-mail, even if the junk filter is turned off. Like the Safe Senders tab, click the Add button
to add blocked senders. You can add specific addresses, such as jim@acme.com, or just a domain, like acme.com.

Once you’re done entering your settings, click OK to apply them.
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Summary
In order to be effective at work, it is important to keep your work area and your electronic files organized.
Remember that file retrieval systems work best when like items are grouped together, there’s a place for
everything and everything is in its place, and everything is labeled clearly. Outlook 2007 lets you organize items by
color, through custom folders, e-mail rules, and Category Search Folders. And if you do happen to misplace
something, the Search function is always available to track down the missing item.
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